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Axicon 6000, 6500, 7000 series

This document was made using:
2.2.8 version of the Axicon Linear Verifier Software for Windows 10.

This document is copyright to Axicon Auto ID Ltd and may not be copied in whole or in part,
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Axicon 6000, 6500, 7000 series

Important information

The Axicon verifier is a high precision opto-electronic device and should be handled
carefully. Please keep and use the case to protect the verifier when it is not in use.

Only use power and data cables supplied by Axicon as the use of non-approved
accessories will invalidate the warranty. If the verifier is dropped (or subjected
to similar misuse) the accuracy of the results may be affected and it should be
returned to Axicon immediately for servicing.

We recommend that the verifier is factory serviced annually to ensure that it
remains compliant to ISO/IEC 15426-1. The unit should be returned to Axicon or to
your approved Axicon reseller for this servicing.

Software updates are always available free of charge, and can be downloaded from
our website, www.axicon.com
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Axicon 6000, 6500, 7000 series

Introduction

What is in the case.

One or more of the following verifiers:

o Axicon 6000 series verifier with USB cable.

e Axicon 6500 series verifier with USB cable.

e Axicon 7000 series verifier with USB cable.

o Software CD.

o Wallet containing this user guide and calibration card.

The Axicon verifier is designed to work with any PC running a version of Microsoft
Windows currently supported by Microsoft.
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Axicon 6000, 6500, 7000 series

Installation

Software installation.

Insert the CD into the CD drive. The Install Program should run automatically (if
not, open the CD using Windows Explorer and double-click the Autorun Program).
Click Install Axicon Verifier and follow the installation instructions after agreeing
to the licence terms and conditions.

At the Custom setup window, the boxes relating to Drivers and Main Program are
automatically selected. It also provides for optional extra plugins (see page 7).
After installation is completed you will find the Axicon Verifier directory in Start
Menu/Programs and a shortcut to the program on your desktop.

If you have downloaded the software from our website then simply click on the
setup file and follow the instructions.

Hardware installation
Plug the verifier into any
available USB port on the
computer. For Windows
7, Windows 8 and
Windows 10 installations
the drivers should be
installed automatically.

ﬁl Axicon Linear Verifier Setup — X

Custom Setup
Select the way you want features to be installed.

Standard plugins, for ISBN, UPC
and GS-1 codes. Also indudes Job
Reference and Lookup plugins.

Click the icons in the tree below to change the way features will be installed.

I = | v| Axicon Linear Verifier
() & ~ | Drivers
- X _~| Extra Plugins
- X_~ | Other Utility Plugins

This feature requires OKB on your

e X ~ | Other Analysis Plugins hard drive.
Lo 3+ | Pharmaceutical Plugins
Browse
Reset Disk Usage Back Cancel
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Axicon 6000, 6500, 7000 series

Note: Please follow these installation instructions in the correct order, namely
installing the software before the verifier is plugged into any USB port. If the
verifier is plugged in before the software has been installed, Windows will attempt
to find the correct drivers for the verifier via the internet, and choose an incorrect
option. This then causes problems as the software is unable to install the correct
driver.

When you reach the Custom setup window you will see a selection of optional
plugins. The Drivers and Basic Plugins are selected by default. If you require

other plugins then simply select one or more of the Extra, Utility, Analysis or
Pharmaceutical plugins.

The Axicon Linear Verifier software includes several programs that are installed
automatically and which are not normally accessed by users. These are programs
that enable different functions for particular applications. These include Choose
Language, Inline Verifier, RepGen, Scan File Data Extractor, and Verifier Help.
You can access these via the Windows Start menu, and they are in the Axicon
Verifier folder.

Choose Language, explained on page 26, allows you to change the default language
of the software.

Inline Verifier is used only when a 6525-S or 7025-S verifier is used to verify every
barcode printed by a thermal printer.

RepGen is used to create reports from sets of Axicon verifier scan files. Instead of
looking at each scan file individually, you can choose to create one file that includes
all the data that you want about each verification, and that can be added to as
each verification takes place. Details about how you set up your report template
are provided in the Help files of the main software.

Scan File Data Extractor is the precursor of RepGen, and is provided for backwards
compatibility.

Verifier Help is all the help information that is normally accessed via the Help
menu shown on the Command Window of the Axicon Linear Verifier software.
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Holding the verifier

The Axicon verifiers are all designed to be used with the verifier positioned so that
it touches the barcode, as shown in the pictures opposite.

Each verifier can be controlled via the software, and they also have a button to
take a scan. The button on the 6000 series is underneath the read head. The 6500
and 7000 series each have two buttons on the top. These have the same function so
use whichever button is more convenient.

Wait for at least a minute after switching on the verifier (when the red LEDs will be
illuminated) before using it. This allows the circuitry of the reader to stabilise.

It is important that the front flap of the 6500 or 7500 verifier is closed so that as
much ambient light as possible is excluded from the verification process.

If the code you are verifying is printed around the circumference of a curved
surface, the varying distance of the reader from the code may produce inconsistent
results.

Press the trigger button. The reader will beep and the data from the first scan will
be displayed in the software immediately. For full ISO/IEC verification you should
scan the barcode ten times, moving through its height and avoiding the top 10% and
bottom 10%.
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Axicon 6000, 6500, 7000 series

The Axicon 6000 series - All four
corners of the verifier are touching
the surface. The 6000 series verifier
cannot be used for symbols wider
than 66mm, and this dimension
includes the quiet zones.

The 6500 series can be operated
either horizontally or vertically (on
the side of a carton) but always in
contact with the barcode. The 6500
series verifier cannot be used for
symbols wider than 125mm, and this
dimension includes the quiet zones.

The Axicon 7000 series is being
placed flat onto the label with the
barcode in the field of view. The 7000
series verifier cannot be used for
symbols wider than 200mm, and this
dimension includes the quiet zones.
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Getting started

When you first start the software you will see the Command window and the
Summary window.

Ilm Axicon Linear Verifier - Command Window - X
File Edit View Options Help

(= = I =uE v B

Display scan |0 :|011U| il Lastscan 0 ? of | 8

Reader 5093 activated

The Command window gives access to all of the main features of the verifier. Use
the pull down menus or the icons to operate the software.

”.Hﬂ The Summary window shows the overall print quality of the barcode as
measured in accordance with the ISO/IEC standards.

Foe S~ |

Average This Scan
Grade

Average Bar Gain (tolerance)
W/N Ratio, X dim

Check Character

Structure

Left Margin

Right Margin

Aperture

Date & Time

Reader Info

Information is also given on the:

e bar gain (ink spread or bleed),

« the size of the x-dimension (the width of the narrowest bars)

» validation of the check digit

e structure

« the quiet zones (the clear spaces or light margins each side of the barcode)
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Calibration

Calibration should be carried out

after installation and at regular
intervals. When the software detects
an uncalibrated reader the following dialogue
box will appear Reader XXXX has not been
calibrated. You must click OK to continue.
You will also need your calibration card which
should be located in your documentation
wallet.

For the Axicon 6000 series use the EAN-13
calibration code at the top of the card. For
the Axicon 6500 and 7000 series use the large
GS1-128 calibration code at the bottom of
the card.

Calibration is a quick and simple process.
Select Calibrate from the Options menu

of the command window (or press F2). You
will see a window with two edit boxes for
minimum and maximum reflectance values.
Ensure that the values shown in the window
match the values printed at the bottom of
the calibration card. Modify the figures on
the window if necessary to ensure that they
are the same as the card.

With the Calibration window open scan the
calibration barcode 10 times. Then click the
OK button. The verifier is now calibrated

and ready to use. After calibration, store the
calibration card in the documentation wallet,
away from light and physical damage. If your

Axicon 6000, 6500, 7000 series

m Calibration Card

EAN-13

900">

57012345778

Data Matrix

GS1-128

)05012345678900

Serial Number:

In service date:

Expiry Date:

This card is NIST traceable

Calibrate : 5083 >

Sample Reflectance

MinirnLn 3 ﬁ
b agirnuim a8 j‘

Set the walues above to the minimum and masinum
reflectances written on the calbration code. Scan the
calibration code carefully 10 times. Then click "OK"

calibration card should ever become damaged or discoloured, please contact Axicon

or your supplier for a replacement.
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Software windows

There are five more windows you can open to look at the verification results. Go

to the View menu on the Command window, and the select the window you want,
or use the icons that appear just below the menu headings. If you hold your mouse
over each icon a brief description of its function will appear at the bottom left
of the Command window. The four most important windows are briefly described

below.
ﬁ Details o R
Ll This window shows each of the  Zoie=e===l

ISO/IEC parameters that are E— verage [ [Ths o] |
measured and individually graded (as ﬁ OVERALL ETeE)
both grades and percentages). Seven un retecance [ (R D Ba AAD  oe
parameters are graded and the lowest ~ smowme] T P [Fex b76% b7.6%
single grade becomes the overall grade | " e [HeEED wre »e
for that scan. If the Summary window *= ] I
has shown poor print quality then the el ey e Ay 2o
Details window is the ideal point to ] e @ e aan i
lnltlally see what is wrong with the = Defects M@0y 23% A@AD  23%
barCOde. ¢ nesdeniy A(D)  B18% A4 B18%

& Show average of scans Decode A 4.0y A0

" Show sean 1 of 3

ﬁ Scan reflectance profile

The scan reflectance profile window shows you what the barcode will look
like to a scanner. At the top of the graph are the higher levels of reflectance from
the background and at the bottom of the graph are the lower levels of reflectance

e

from the [ e e e ey | P —
darker bars. | T Fin | Com || St B I Dt ™ Modion
TR Vi PV
N ffodi o foy H
: (‘f ( f LEsr \‘w/\ \{ Fl
L
: ‘ 1
= “ 1 \} i \I ‘\ | T ‘\ "
N iR R R ARl IR R R
RN ARYERE | ERHNANARI Il P
En | AN | [ERTNANAR il A |
i | A R [ENH . |
lf\ w‘\ i “J\(‘ WA T o w\‘\
" Vil U A b R U L

=3 a2
Conen76%, A 4)
i)
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ﬂ . Axicon 6000, 6500, 7000 series

Dimensional Analysis [ = =
@ If the Details window !Ll“l..,._._“.l“l

has shown a poor IO T TS T
Decodability grade then o " STt T e
this is normally because of e i

bad dimensional accuracy
- this screen will show the T
accuracy of the bar/space |
dimensions and highlight ]
any problem areas. -

i

Pass / Fail = = aa mihd =)
0214697004009
‘vf This window is ideal
for users who need

a quick visual indication of
whether the barcode meets
the right print quality
standards.

GenSpec Symbology Consumer or Traded unit

214697004009

To scan another code, press the 'Delete’ key.

Rearranging the windows

Most of the windows described above can be moved, expanded or shrunk as
required. When you have decided which windows you would like displayed on your
PC just use the View pull-down menu and click on Save Positions. Then whenever
the software is started it will always have those windows in those positions.

The help menu from the command window gives you access to context-sensitive
help about the software. It also has a search function to find relevant information.
The F1 key can also be used as a shortcut to switch on this help.
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Continuous scan

". The Axicon S range verifiers have

I a unique continuous scan feature.
When first installed this feature is
automatically activated on start-up (but
can be de-activated if required) and
allows the user to get an assessment of
the barcode quality in a fraction of the
time that it would take with other linear
verifiers.

The verifier should be placed either just
above or just below the barcode and the
trigger pressed. With the trigger still
pressed, move the verifier down the height
of the barcode. The verifier will scan at
the rate of 100 verifications a second until
it reaches the bottom of the barcode (or
gets to the maximum number of scans).

The verifier will automatically calculate an
average of the results of all of the scans
to provide an overall quality grade based
upon an assessment across the scanned
bar height.

When verifying barcodes on awkward
shaped packaging you may find it easier to
switch off the Continuous scan mode. This
feature can be activated or de-activated
as required with a toggle switch on the
Command window.
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Selecting the verifier

If you have more than one verifier plugged into your computer at the same
? time (for example a 6015 and a 7015), you will need to choose which one you
want to use. If the LEDs are not illuminated on the verifier you need, go to
the Options menu on the Command window, and then choose Show Reader Info (or
use the shortcut F3).

r"ﬁ] Reader Info = | B
List lLDg I Info ]

% % 5 ey i

' e

530 [USB] 5093 (USEZ) ComMo COM1 ComMz2

[Unknown) [Unknown) [Unknown)

-

..
COm3
[Unknown]

I:gp_l,llng | ListView| agnumelate ? Help | x Cancel ‘ |

Reader.Enumerate returns 2

L

A new window, Reader info, will appear.

At the bottom you see the button Enumerate. Click on this and in a few moments
all the connected verifiers will be displayed as small icons. The first four characters
are the serial number of each verifier which is clearly marked on each one. Double
click on the icon for the particular verifier you wish to activate.
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Setup

All of the primary configuration of the verifier is done through the Setup
$ section. From the Command window choose Options then Setup or press F5.

General

Setup *
General lgheck Eharacters] Qppearance] F'[inting] I:ogging] Ealil_:ration] Elugins] Email ] Advanced

Standards Pass Grade
¢ 1SO/EC v Apply G51 General Specifications
Lowest Pazs [Other Codes):

o ANS| CE -

[~ Check GenSpec codes against pass grade

Units:

€ Metric G51 Scanning Environment:

" Imperial " General Retail/Hand 5canning
{* Default f* Automatic

" Fixed Scanners [General Distribution]

x Cancel
2 o |

“? Hep

H jul

Standards: Click on ISO if you want only the numeric ISO result to be shown - or
click on ANSI if you would prefer to be shown both results. The default is to track
the Windows settings for metric or imperial measurements - alternatively you can
set this as required.

Pass Grade: If you are working with GS1 barcodes then the Apply GS1 General
Specifications should remain ticked. The user can select the pass/fail grade for
other barcode types as specified either by an industry application specification or
by their customer.

Axicon Auto ID Limited | Linear verifier user guide | July 2020
Page 16 of 32



Check Characters

This tab allows the user
to select the barcode
types that have
optional check digits.

If these are being used
then the verifier can be
set to validate them.

Appearance

This tab can be used
to adjust any display
colours/shades for the
pass, warning and fail
messages - and can
also be used to add
Windows wave sounds
to give an audible
indication of quality.

Axicon 6000, 6500, 7000 series

Setup X

General Check Characters Anpaalamcal P[inling] L_oggimg} Ea\it;ration] Elugins] Email } Adgamcad]
Interleaved 2 of &

" Do not verify check digit
& Verily check digit

Code 33
" Do not verify check character

& Verify Modulo-43 check character

Codabar
& Do not verfy check character
™ erify check character

151 Plessey
{* Do not verify Mod-11 data check character

" Verify Mod-11 data check character

X Cancel
2 b |

?  Hep

Setup

X

generall LCheck Characters  &ppearance ]P_rinling] I_.oggimg} Ea\it_:ration] Elugins] Email } Adgamced]

Colours Sounds
-
‘wiam ‘ Wam

|
Defauls

Clear

Pl

[v Beepon Decode

Custorn Pass/Fail Display

|Standa|d j

Mote: changes to this setting will not take
effect until the program is restarted,

Pass/Fail shows wamings in

" Failure Colowr

{* wWarning Colour

¥ Fal margins on single infringement " Pass Colour

x Cancel
?  Hep
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Axicon 6000, 6500, 7000 series

Setup

Printing

This tab can be used
to pre-select any
particular reports that
are required. This
includes the option to
have a personalised
report generated
through the built-in
Report Generator.
The verifier software
can also be set to
Autoprint to avoid
forgetting to print a
particular report.

Setup
Qeneral] Check Chalactars] Appearance  Printing Il:oggimgw Ea\it;ration] Elugins] Email } Adgamcad]

Print Carmmand

¥ Standard Repart

[ Reflectance Prafile

[ Dimensional Analysis

[ Traditional Analysis

[ Custom Report via ReplGen

RepGen report template file;

Browse:
Output file extension:

Printing options:
™ Auta Print
™ Use Smaller Font
[ Print graph in black, & white

Report header:

|Akicon Barcode Yerfication Repart

X Cancel

il

?  Hep

Tick Print graph in black & white if you are using a monochrome (black and white)
printer, otherwise a scan reflectance profile will only show the outline and not
the detail. Also, the standard printed report can be personalised if required using

the Report header
feature.

Logging

Setup
Qeneral] LCheck, Chalaclars] Appearance | Printing  Loaging ] Ca\ii_:raliun] Elugins] Email 1 Ad!anced]

Auto Save Scan File
Directary,

|C. U zershDocumentshS aved Scansh

X

i i I~ Enabl
The LOggI ng tab 15 . i~ U';: Nel,lmbel and Time as Filename Ecket
used tO Set the SaV]ng [T Show "Save As..." Dislogue
of records and to run e _
. ormrmand to run when files are saved:
pre-configured external | || Browss...
rograms from the Cornrnand Parameters:
p . |Zs
ve r]ﬁer' i Fun when file iz auto-saved
If the Enable box is ¥ Fiun for manually saved fles Configure RepGen... v DK
. Simple CSY File
t]Cked under the AUto |C:\Usels\Documents\Saved Scanshautosave.cav Browse... X Cancel

Save Scan File section
(at the top) then the
software will auto save

[ Auto Save data to C5Y
¥ Save Pathto Scan File in C5Y

-
=

every scan file in the chosen directory.
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The files saved through this process can be regarded as audit quality records of the
verifications made and can also be used for remote diagnostics purposes. The files
can be saved automatically with a filename comprising the decoded number, date
and time and a sequential number, or by using a dialogue box.

Save File Log allows users to run any Windows program each time a file is saved. It
is intended for use with RepGen or ScanDB, but could be used to perform any action
on the saved file.

Simple CSV File allows a subset of the scan information to be automatically
appended to the specified file in CSV format.

Calibration Setup X
generall Check. Chalacters] Anpealamcel F'_rinling] Logging  Calibration IEIugins] Email } Adgamced]
The Calibration tab Caltration File
Spec]ﬁes the ﬁle and |E \ProgramD atatasicon\Werifiers\Calibration. LOG
directory in which o Bl = B
Cal]brat]on data W]ll v Allow scans after calibration has expired
be Saved Th]S can be ™ Require Setup Password for calibration
3 3 Aillowed Calibration Codes Calibration Scan Actions:
altered by clicking o i ™ Fun Phins
on the brqwse bUtton £070507 2345678300 Pl L
and ChOOSlng the 0072345673305
. . [v Enfarce

required directory = ¥ o
and filename. If Allow % Carcel
scans after calibration

. . ? Help
has expired is not

ticked, no scans will
be allowed until the
verifier has been calibrated. Within the Allowed Calibration Codes is a list of the
data content of barcodes with which calibration is permitted
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Setup

Plugins

The Plugins tab
allows the software
to be tailored to
industry specific or
user specific features,
such as running

a product lookup
database, validation
of the structure of
variable weight items,
or identifying the
formats of European
pharmaceutical codes -
and a whole lot more.

Setup

Qeneral] Check Chalactars] Anpaalamcal P[inling] L_oggimg} Calibration  Plugins IEmaiI } Adgamcad]

AAG_GTL

] AlCheck
A|Date
AUS_Vanable
Branded
c3asci
39pharm
CaseMumn
cip39
Camments
Coupon
DieliveryD ate
EwroCoupon
FileData
GenericMCU

InStore
isbn

v jobref
LengthCheck.
lookup
LFFR
&S
tSIPharm

& 0K
X Cancel ‘

[ad .
Configure | Enable All |
Dizable Al
[ Plugin settings shared by all users
Plugin buffer size:
=]
1.024 =
Flugin Test
Code:
| Function 1 |
Symbology: ‘
2 I~ Display Clear List
v

?  Hep

An explanation of what each plugin does is on our website.

Email

The Email tab allows
scan files to be
emailed. Users can
configure the From:
and Destination
address, and the email
server to be used. You
can also enter the text
to be used in the email
body here.

Setup

Qeneral] Check Chalactars] Anpaalamcal P[inling] L_oggimg} Ea\it;ration] Pluging  Email ]Adgamcad]

Addresses

From:* address:

Email body text:

— \

Destination address:

¥ Prompt for destination address every time

SMTP Server:
Server address:

Port:

Authentication:
Type:
User name:

Pagsword

——

25 =

Hone -

—
——

0K

X Cancel
? Hep
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Axicon 6000, 6500, 7000 series

Advanced Setup x
Qeneral] Check Chalactars] Anpaalamcal P[inling] L_oggimg} Ea\it;ration] Elugins] Email  Advanced
There are Several ‘When bar code cannot be decoded Mizcelaneous
. . ¥ Clear existing scan ¥ Allow Scan whilst pluging update

Sett] ngS mn the W Shaw erar dialog v Show aperture waming dialog

[ Enter data manually :
Advanced tab . If a [ Default to last decoded scan I:hmmumjans LR

=1

barCOde 1S SUCh a poor Default Save File Mame W Automatically clear scans
quality that the verifier | | #ependDatandTime

. v Permit non-A5C1 characters UPC/EAN magnification factor
cannot decode it then - Magniator
. . eplen 30 B
there is an option to 7 EN=

[ Debug RepGen & saved file log ¥ Ask Every Scan

manually input the
barcode under When

barcode cannot be — %K Cercel

decoded. Use RepGen |
for CSV file save is
ticked by default: this
means that simple CSV file saving is performed using repgen.exe and the supplied
template file csv-template.txt.

?  Hep

UPC/EAN magnification factor is for users using the discontinued Axicon 5000
verifier.

The Password for Setup allows password protection of the settings in the Setup
dialogue. This is useful for ensuring features such as the Pass/Fail grade and file
saving directories can only be altered by an authorised user. To apply a setup
password, enter it in the Password for Setup box and click OK. You will be asked to
re-enter the password you gave. Now, to alter the settings you must enter the same
password into the Password for Setup again before you click OK.
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Android app

|||| An app that allows Axicon barcode verifiers to be used on the move with
either Android tablets or Android smartphones is now available from
Google Play. Free to use, this app allows anyone with an Axicon 6000,
6500 or 7000 series verifier to use it with an Android device, and record
the results as easily as with a PC or laptop.

Most users will need to use a USB OTG (on the go) adapter for their device, and
they will need to check which one they require to connect to the verifier.

Calibrate

Before any verification scans the verifier

will need to be calibrated. Calibration Axicon Linear Veri... :
is achieved in the same way as the PC

software using the same calibration card. 4.0/06/660 (A)

Select the menu on the top right of Average 10f 3 20f3 30f3

the screen and then ‘Calibration’. The

message below will appear. Scan the RO125H5625200
relevant barcode (see page 11) three times Sl A
and calibration will be complete. General
Time: 16/03/2017 14:51:04
X Dimension: 330 pm
Gain: 20 pm (6%)
Gain Tolerance: +31%
. Magnification: 100%
Calibrate Reader pre o 06
Left Margin: 3 Pass, 0 Fail
Calibration mode: make 3 scans Right Margin: 3Pass, 0 Fail
tO Complete Check Character: Pass ('0')
ISO Parameters
Overall: 4.0 (A)
Minimum Reflectance: 4.0 (A) 51%
CANCEL GET SCAN Qumhnl Contrast: AD(AY 79 7%
Reader

Scan loaded successfully: 5012345678900-20170316-145104.scn

Clear Scans
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Axicon 6000, 6500, 7000 series

The app software is based upon the Axicon PC verifier software, so the results of

the verification are displayed equally clearly, with the ISO/IEC grade together with
details of the individual parameters.

The screen shots below show the data content results displayed at the bottom for a
GS1-128 barcode.

Swipe from right to left to view each scan. The average result is always shown first.

Axicon Linear Veri... A Axicon Linear Veri...
0.7/10/660 (D) 0.7/10/660 (D)

Average 1of3 20f3 30f3 Average 1o0f 3 20f3 30f3
F1 01080328917040731517071010L17166 F1 F1 01080328917040731517071010L17166 F1
Symbology: GS1-128 Symbology: GS1-128

Left Margin: Pass
Right Margin: Pass General
Check Character: Pass (70) Time: 22/06/2017 13-2513

ISO Parameters . Data Content:

p— 07 (D) (01)08032891704073(15)170710(10)L17166
Minimum reflectance: 4.0 (A) 10%
Symbol Contrast: 40(8) s0% (01080922917 (15)170710  (10)L17166
Minimum Edge Contrast: 4.0 (A) 36% —
Modulation: 1.3(D) 45% Best Before Date (YYMMDD) [n2+n6]
Decodability: 1.0 (D) 32%
2017-07-10
Defects: 4.0 (A) 7%
Decode: 27(8) 67% Using passed date

Al (15) must be processed together with Al: GTIN or (8006)
Data Content:

‘ (01)08032891704073(15)170710(10)L17166
Reader Reader

Scan loaded successfully: 01080328917040731517071010L17166.scn Scan loaded successfully: 01080328917040731517071010L17166.scn

Clear Scans Clear Scans

Axicon Auto ID Limited | Linear verifier user guide | July 2020
Page 23 of 32




Axicon 6000, 6500, 7000 series

Android app

Menu

The 3 dot icon on the right hand side of the app will
display the following menu. ‘Load Scan’ is where any
previous scans can be viewed and ‘Save Scan’ is where
individual scans can be saved. ‘Print Report’ can be used
to save the verification report to PDF. The menu is also
where you can view the ‘Encodation’ of the barcode.

‘Show Profile’ option is where you can view the scan
reflectance profile of the verification scan like on the PC
software (see page 12).

‘Clear Scans’ option clears the existing scan; this option
is also at the bottom of the main screen. For settings
menu please see next page (page 25). ‘About’ displays
information about the Android app build details.

Load Scan...
Save Scan...

Print Report...
Show Encodation
Show Profile
Clear Scans
Calibrate
Settings

About
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Axicon 6000, 6500, 7000 series

Settings
Settings includes these two options, ‘General Application Configuration’ and
‘Calibration Configuration’.

General is where you can set number of scans (scan set size), minimum pass grade
and enable auto save. (The saved scan files records can be transferred to a PC and
form the basis of any quality control system.) The volume button can be used as a
trigger and the measurements changed to display imperial units.

Calibration is where changes to the minimum and maximum reflection values can be
made to match the calibration card and change the calibration expiry date.

Scan set size Minimum reflectance
3 3%

Pass grade (I1SO) Maximum reflectance
1.5(C) 88%

Calibration expires after (days)

Enable autosave 0

Save to a new scanfile when set is
complete

Enable volume button triggers
Make scans by pressing the physical .
volume up/down buttons

Use imperial units
Display physical dimensions in inches
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Axicon 6000, 6500, 7000 series

Changing the language

The Axicon Linear Verifier (ALV) software will automatically use the computer’s local
Window system’s locale to determine the language that will be used. If you want to
change this language, go the Windows start menu (by clicking on the Windows logo
in the task bar), and find the ‘Choose Language’ software option within the Axicon
verifier heading.
You do not need

# Language Selection Utility

to open the Axicon | Rectow Programs Available Languages
. . = Ch [ venttier.exe i
Linear Verifier (= Program Files (x86)
software to do £ Asicon
.
this. (£ Drivers
Click on ‘verifier.

exe’ in the IVeIifiel.exe | 4' 4' 4' EI

central panel’ | ¢ [os] | Default Windows locale:
and then choose English [United Kingdom)

C:A. Micon'\Werifier
the language you
require from the
list that appears on the right.

# Language Selection Utility

Once you have

chosen the Directory Programs Available Languages
= CA Chinese (Simplified, China)
language you &= Program Files (+86) Ehiniseéﬁa:ilional, Taiwan) =
require, click on (= Axican ooy
German [Germany)
Set, then close ) Drivers Spanish [Spain, Intemational Sor
this window. French [France]
Italian (Italy)
Now start the ;J(apanesrs [Jap1an] %
ALV software and |
i Veiifier.exe ;I Set Default| Onginal| About
you il see that - S
= = anguage for verifier. exe: efault Windows locale:
the Change haS l ¢ [os] _I French [France) English [United Kingdom)
b d | f CA NAsicon'Werifier
€en made. "FRA" read from "C:\Program Files (x88)\Axicon\Verifier\verifier.exe"

you want to see
the software in English, you will need to click on the ‘Default’ button beneath the
right-hand panel listing all the language options. Then close this window and re-
start the ALV software.
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Axicon 6000, 6500, 7000 series

Software licence agreement

This software is Copyright © Axicon Auto ID Limited

Use of the software is subject to the Axicon software licence terms set out below.
Using the software indicates your acceptance of these licence terms. If you do not
accept these within 14 days, you may return the entire unused product for a full
refund.

Axicon grants you a licence to use any number of copies of the software, but only
for use with an Axicon verifier. “Use” means storing, loading, installing, executing
or displaying the software. You may not modify the software or disable any of its
licensing or control features.

Ownership

The software is owned and copyrighted by Axicon Auto ID Limited. Your licence
confers no title or ownership in the software and is not a sale of rights in the
software.

Copies

You may only make copies of the software for archival purposes or when copying is
an essential step in its use. You must reproduce all copyright notices in the original
software on all copies. You may not copy the software onto a bulletin board or
similar publicly accessible system.

No disassembly or decryption
You may not disassemble or decompile the software without prior written consent
from Axicon.

Transfer

Your licence will automatically terminate upon any transfer of the software.

Upon transfer, you must deliver the software, including any copies and related
documentation, to the transferee. The transferee must accept these licence terms
as a condition of the transfer.

Termination

Axicon may terminate your licence upon notice of failure to comply with any
of these terms. Upon termination, you must immediately destroy the software,
together with all copies, adaptations and merged portions in any form.
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Axicon 6000, 6500, 7000 series

Software licence agreement

Export requirements
You may not export or re-export the software in contravention of any applicable
laws or regulations.

This agreement should be construed in accordance with the laws of England.

DISCLAIMER
In the following the expression “verifier” means the verifier hardware and the
associated software.

We have taken care to ensure that this verifier is free from defects. However since
we have no control over the circumstances in which you might use it you must
satisfy yourself that it is suitable for your needs. Neither Axicon Auto ID Limited
nor the vendor of this verifier can accept any liability for any loss or damage
(consequential or otherwise) which may be caused by its use.

If the verifier or any part of it is defective in any way, or in some other way does
not meet your expectations, the liability of Axicon Auto ID Limited is limited to the
cost of the product. You should bear this limitation in mind if you use this verifier
in any situations where the acceptance or rejection of shipments of goods or your
reputation may depend upon the quality of a barcode.

Axicon Auto ID Limited | Linear verifier user guide | July 2020
Page 28 of 32



Axicon 6000, 6500, 7000 series

Warranty

All Axicon products covered by this documentation (Axicon 6000, 6500 and 7000
series verifiers) are sold with a two year parts and labour warranty against
manufacturing defects. This is a return to bench warranty with shipping costs in one
direction being borne by the customer/distributor.

Should you need to return the unit to Axicon the original case (plus appropriate
packaging) must be used. If the equipment is returned without the original case, we
will automatically charge an additional sum for its replacement.

Axicon’s standard repair turnaround time is 7-10 working days. This standard
warranty does not include the provision of a loan unit. Loan units can be supplied
on request.

Axicon reserves the right to charge an inspection fee for any equipment returned
under warranty for which no fault is found. Please contact us to obtain an RMA
number before returning any equipment. This number must be quoted on all
documentation. We cannot accept responsibility for equipment returned without an
RMA number.
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Axicon 6000, 6500, 7000 series

Maintenance agreement

A service contract may be purchased within 30 days from the date of despatch.
This allows you to return your verifier back to us at no extra cost for its annual
VCAS (verifier conformance and alighment service) so that you can be sure it still
measures barcode quality in accordance with the requirements of ISO/IEC 15426-1.

The service contract will also extend the warranty beyond two years, so that if it
breaks down, all parts and labour will be provided free of any extra charges. The
only exception is when the verifier has been misused, in which case labour costs
will be covered, but not those of the parts.
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Axicon 6000, 6500, 7000 series

Annual service

All verifiers need servicing every year to ensure that they measure barcode quality
in accordance with the relevant ISO/IEC standards. This verifier conformance and
alignment service (VCAS) ensures that the verifier is internally dust-free, checks
that it is focused correctly, and adjusts the hardware to account for any change in
the brightness of the LEDs used to illuminate the barcodes.

This annual service is not the same as user calibration, as it looks at the output of
the LEDs and corrects for any variance in their evenness of illumination across the
whole field of view. Over time the LEDs will fade but they will not fade uniformly.
User calibration ensures that the verifier is measuring the darkest and brightest
reflectances correctly but it cannot correct for any variance in the illumination.

After your verifier has been serviced, we will return it you with the latest version
of the software on CD together with a new calibration card, a new user guide and a
new certificate of ISO/IEC conformance. You will then need to calibrate the verifier
before you use it again. The latest software can always be downloaded free of
charge from our website, www.axicon.com.
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Contact us

Axicon Auto ID Ltd
Church Road

Weston on the Green
Oxfordshire

0OX25 3QP

UK

Tel: +44 (0) 1869 351 155
Fax: +44 (0) 1869 351 205
Email: info@axicon.com
Website: www.axicon.com

As Axicon continually improves its products, their specifications and features are
subject to change without notice. All trademarks are acknowledged as belonging to
their respective companies.

Your Axicon distributor




